
 
Dreamweaver Templates and Styles 

 
 

Site Management 

Site Management is a mechanism used to keep track of web pages you build for a specific web 
project and the assets you use in them.  Think of  Site Management as a holding tank or a central 
storage location for all related files, also known as a  Root Folder. 

Creating and Defining a Site 

Create a Site prior to building any pages for your web project.  The Site you create will have a 
unique name and a storage folder, Local Root Folder, which will be used to hold all the related 
pages for the web project.   Note, all items used in your web project must be stored in the 
specified Local Root Folder, which you specified within the Site for the project. 
 
From the Menu toolbar select Site, New or Press the shortcut key F5  to open the Site Definition 
dialog box. 
Tip:  Select the Advanced tab to bypass the Basic Wizard setup. 
 

Specify a Site Name by clicking with 
the mouse in the Site Name field.   
 
The Site Name is an internal naming 
convention.   When naming the Site, 
don’t worry about spaces or 
capitalization.   The Site Name is 
like a “pet name” for your project.  
The Site Name is never transferred 
to the Web or Remote server. 
  
Select the Folder icon to the right of 
the Local Root Folder field to create 
a new Local Root Folder or browse 
and select the folder that will hold 
the web site and be known as the 
Local Root Folder. 
 
All files and assets that you plan on 
using in your web project must be 
stored in the Local Root folder. 
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When back to the Site Definition dialog box the Local Root Folder should display the folder 
name just created or selected.   
 
All the files and subfolders that you use for your Site should be stored in the specified Local 
Root folder so that when you create your pages, the graphics and links are relative to the that 
folder.  When you get ready to publish, you will only need to copy the root folder, which will 
contain all files and subfolders, and copy (Put) them on the Remote Server (Web Server) from 
your Local computer.   
 
When you Put your Site on the Remote Server, Dreamweaver will maintain an identical 
directory structure as your Local Root to ensure links and references work.   
 
New to MX:  The Site dialog box needs to know where all the images are stored within your 
Site.  Use the Default Images Folder field to point to the folder within your Local Root Folder 
that will contain or hold all images for the files within the web project specified in the Site dialog 
box.  Note, if you don’t have a folder created for your images, then click with the mouse on the 
Folder icon to the right of the field and create a new folder to house the images. 
 
From the Site Definition dialog box be sure to select the Refresh Local File List Automatically 
so that Dreamweaver updates the site list when it has been modified.    
 
From the Site Definition dialog box be sure to select the Enable Cache .  This feature will create 
a cache that will help increase the speed for link management while working in Dreamweaver.  
The Site is now defined.   
 
 
 

Browser Preview 

Dreamweaver is a WYSIWYG program, meaning what you see is what you get.  However, it’s 
still a good idea to view your page in different browsers prior to publishing to make sure they 
look good.  Dreamweaver lets you set your preferences and specify the browsers you want to 
preview your creation in.  Dreamweaver preferences can hold up to twenty different browsers, 
but the two most common are Netscape Navigator and Internet Explorer.  Note:  you must have 
these programs installed on your computer before you may use the preview option.  Both 
browsers may be downloaded from the Internet. 
 
 Netscape Navigator  à http://home.netscape.com/computing/download/  
 Microsoft Internet Explorer à http://www.microsoft.com/windows/ie/ 
 
The Preview in Browser option is located in the File menu or in the Document toolbar.  From the 
File menu select Preview in Browser and select a browser from the fly-out menu.  The Preview 
in Brower icon located in the Document toolbar works the same way. 
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The shortcut key for the browser is located to the right of the browser name in the Preview in 
Brower fly-out menu.   For example, to launch the Preview in Browser using the Internet 
Explorer browser, press F12. 
 
Adding  Browsers  
To add or delete a browser, choose Edit, Preferences,   and 
select the Preview in Browser category.  From the Preview 
in Browser dialog box, select the Plus icon to add a new 
browser or the Minus icon to remove a browser. 
 
Tip:  Internet Explorer is the default primary browser.   
 
 
 

Creating A Basic Web Page 

Dreamweaver opens with an empty 
window, ready to create or open a 
document.  To open a new window 
choose  File,  New.      
 
Select the Basic Page Category and 
the HTML Basic Page from the New 
Document dialog box. 
 
Press the Create button to generate 
the new page. 
 
 
 
 
 

Saving Your File   

Always save your document as soon as you open a new document by choosing File, Save As.   
Name your files with meaningful file names and use lowercase letters or numbers for your file 
names.  Note, when naming and saving your files don’t use spaces in your file names; instead 
use the underscore or dash.  Dreamweaver automatically adds the extension .htm to your file 
name when you save.   You can change the file extension by choosing  Edit, Preferences and 
change the Add Extension When saving option from the General Category.   
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Adding a Title  

Always give every HTML document a title.  The document title appears in the title bar of the 
Dreamweaver window and the browser title bar.   It’s important to give your title a meaningful 
name because the title name will be used as a browser bookmark or favorite.   
 
A title can be added by using the Title field in the Toolbar 
 
 
 
or by choosing  Modify, Page Properties.    Page Properties can also be accessed by right-
clicking with the mouse and selecting Page Properties from the menu. 
 
Notice  (untitled-1*) appears to the right of the page title.  This text is displayed because the file 
hasn’t been saved yet.  Once the file has been saved the (untitled-1*) will change to display 
filename. 
 
 

Modifying Page Properties 

Page Properties include the title, background color, background image, text color and hyperlink 
color.  Choose Modify, Page Properties to edit properties. 
 
 
Style Sheets  
 
A Style is a group of formatting attributes identified by a single name that controls the formatting 
of a text block.  Style Sheets can include fonts, font size, the color of the text, and other options.  
Styles are a good way to keep the look of your web pages consistent. 
 
 Style sheets work in 4.0 (or later) browsers.  Internet Explorer 3.0 recognizes some styles.  
Styles can be used to customize one document, or you can use an external style sheet and link it 
to several other documents. 
 

Types of Styles 

There are three types of styles available from the New Style dialog box in Dreamweaver.   
 
1.) Redefine HTML tag  

The Redefine HTML tag allows existing HTML tags to be redefined. 
e.g.  Heading 1  or  redefine the way links work by using the a tag 

2.)  Make Custom Style  
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The Make Custom Style allows the creation of new styles that can be used in the current 
document or added to a style sheet. 

e.g.  .titletext   à  create a style name and define the style with 
formatting attributes. 

3.) Use CSS Selector 
The CSS Selector allows reformatting of  selective tags, such as the “a:” - hyperlink tag.   

e.g.  a:hover  à modify the hyperlink tag  
 
Create and Apply a Custom Style For the Current Document 
 
Create a custom style and apply to text in the current document.  We will define the font, font 
size, and font color. 
 

• Select the Design Panel and click with the mouse on the 
CSS Styles tab.  

• Select the New button from the CSS Styles 
Palette or select New from the CSS Styles Menu. 

• From the New Style dialog box select the Make Custom 
Style (class) and enter a name for the Style in the Name 
field.    

• Note:  Custom Style Names always begin with a period.  
Dreamweaver will insert the period if you forget.  Also, 
when typing the Style name to not use spaces or 
punctuation. 

• Press OK when finished. 
• Enter the attributes of the style in the Style definition dialog box.   
• With the Type Category selected select a Font, Font Size, and a Color from the pull-down 

menus. 
• Click OK when finished. 
• The new Style appears in the CSS Style Palette. 
• Apply the Style by first selecting text and then clicking on the Style in the CSS Style 

Palette.   
 

Note:  You can also select a Layer or Table and apply the Style.   
 

To remove a style, select the area that has the Style applied to it and choose None  from the 
CSS Style Palette. 

 
 
Redefine HTML Tag 
 

• Open a new file and save it immediately. 
• Open the CSS Styles tab from the Windows Menu 
• From the CSS Style tab, click on the New icon. 
• From the New Style dialog box select Redefine Html Tag option. 
• Select the tag from the tag pull down menu to redefine. 
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• Select the location in which the style will be defined: New Style Sheet File (external) or 
This Document Only. 

• Choose OK when finished. 
 
 

CSS Selector 
 

• The CSS Selector defines the formatting for particular tags 
• Open a new file and save it immediately 
• Open the CSS Styles tab from the Windows Menu 
• From the CSS Style tab click on the New icon 
• Select the CSS Selector from the New Style dialog box 
• Choose a selector from the menu. The selectors available from the menu are a:active, 

a:hover, a:link, and a:visited. 
• Select the location in which the style will be defined: New Style Sheet File (external) or 

This Document Only. 
• Choose the formatting settings for the new CSS style.  
• Choose OK when finished. 

 
 

 
External Style Sheets 
An External Style Sheet can be created using the New Style dialog box from Dreamweaver.  An 
External Style Sheet is a very powerful type of style sheet.  One style sheet, a list of formatting 
attributes, can be linked to several documents.  When a style sheet is modified, it will update 
every document that is linked to the style sheet to reflect the new formatting changes.  
  
 
Creating an External Style Sheet: 
 

• Open a new file and save it immediately. 
• Open the CSS Styles tab from the Windows Menu 
• From the CSS Style tab, click on the arrow located on the right-side of 

the CSS Styles tab and choose Edit Style from the Menu. 
• Select the New button from the Edit Style dialog box. 
• Decide which type of Style you want to create and Define it in 

a new Style sheet.  Click OK. 
• Dreamweaver will navigate you to a Save As dialog box for 

the Style Sheet.  The extension for the Style Sheet will be .css. 
• A Style Definition dialog box will display on the screen where you can customize the 

formatting options for the particular type of style you are creating. 
• Note:  Be sure to LINK the .css file to other files in the site when creating new web 

pages.   
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Edit a Style 
 

• Select the Style from the CSS Styles Palette and choose Edit from the CSS Style Menu. 
• Make the modifications and choose OK when finished. 

 
Exporting Styles to Create a CSS Style Sheet 

You can export styles from a document to create a new CSS style sheet. You can then link to 
other documents to apply these styles.  To export CSS styles from a document and create a 
CSS style sheet:  

• Choose File | Export | Export CSS Styles or choose Text | Export Style Sheet. 
• If the Save As dialog box doesn’t appear, click with the mouse on the MX Window. 
• Enter a name for your style in the  Export Styles as CSS File dialog box click Save. The 

style is saved as a CSS style sheet. 
 
 
Template 
Creating and using templates can be a big time-saver for web developers.  Design one page and 
save it as a template to add consistency to your web site.  A Template ensures that your web site 
has a consistent look and feel, which in turn means it’s easier for users to navigate the site.   
 
The first step in creating a template would be to save your file as a template.  Choose File, Save 
As Template.  Specify a file name for the template and click on the Save button.  Notice the file 
extension for the template is .dwt and the file is saved in its own folder called Template, which 
was generated by Dreamweaver.   
 
Design the template using the cell layout and table tools.  It’s always easier to design your 
overall look on a piece of paper before creating it in Dreamweaver. 
 
Cell Layout Tool 
 
Dreamweaver 4/MX has a tool called the Cell Layout tool.  The Cell Layout tool is similar to a 
cell in a table.  The Cell Layout tool allows you to draw boxes on your web page that can hold 
objects or text in place.   
 
Use the Cell Layout Tool to design your web page.  Draw cells on the canvas where you 
plan to insert images and text as placeholders and then go in and insert images and text.   
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Using the Cell Layout Tool 

 
• Select the Layout tab from the Insert Panel.  Note the Default view is the Standard View.  

Select the Layout view button to access the layout tools.   
 
 
 
 

 
• When the Layout View icon is selected, a dialog box will display explaining how the 

Layout and Standard View work. 
 

• Select the Draw Layout Cell icon to draw a cell on the page.    
Left-click the mouse and drag the mouse to draw a cell.  The   
cell will display in the color blue. 

 
• Notice that Dreamweaver creates a table in the background to house the cell that you 

draw.  The table in the background will display in the color green and will be tagged 
Layout Table. 

 
• Select a cell to resize or drag to a new area on the page.  A selected cell will display in 

the color blue.  Note the Property Inspector can also be used to change the cell properties. 
 

• Select a cell and use the Properties Inspector to change cell properties such as the 
background color of the cell. 

 
• To delete a cell select it and press delete. 

 
 

Inserting Tables 

Many web page designers use tables as a way to organize text and objects because tables offer 
many features such as varied colors for the table background, row, column or even a cell.  A 
table can even be nested inside an existing table and cell, row and column sizes can vary.  The 
user can decide where the table will be located on the page and whether or not the table should 
have a border.   
 

• The Table icon is located in the Insert Panel under the Common tab. 
 

• From the Common tab select the Insert Table icon 
or from the Insert menu choose Table 
(shortcut key  Ctrl+Alt+T). 
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Rollover Images 
A Rollover image consists of two states, a display state and a rollover state.  The display state is 
how the image appears when the user visits the web page.  The rollover state will only change 
when the user moves the cursor over the 
image.  The Rollover Image icon is 
located in the Objects Palette and also in 
the Insert, Interactive Images, Rollover 
Images menu. 
 
 
 
 
Choose File, Save when finished designing the template.  Make sure your template is linked to 
your style sheet. 
 
 
 
Add editable regions to your template. 
What items on the template do you want users to access 
and change?  Click in the area that you want users to be 
able to change and choose Insert, Template Object, New 
Editable Region.  A Region dialog box will open asking 
for a region name.  Type a region name and press OK.  
 
Any area not marked as an editable region on the template will be locked when creating a new 
file from the template. 
 
Creating a new file from a Template 
 
Choose  File, New, and select the Template tab 
from the New dialog box   
 
Select the Site holding the template on the left 
side of the New from Template dialog box.  Select 
the template name displayed on the right side of 
the New from Template dialog box from the 
selected Site. 
 
Make sure the Update Page when Template 
Changes option is selected.  
 
Select the Create button.   
 



 

K:\Ctss_Dev\class_handouts\summer\dreamweavermx_templates.doc Page 10 of 10 
© Computer Training  & Support Services, Colorado State University 
 

 
Save the file immediately by choosing File, Save as, and specifying a file name. 
 
 
Add content to the editable region on the template and save the file when finished.  Choose, File, 
Save As.   
 
Modifying the Template 
 
Modify a template by opening the template in Dreamwaver, the file with the .dwt extension.  
Remember, the template is located folder within your Site called Template.  Modify the template 
and choose File, Save.   
 
The Update Template Files dialog box will appear and 
display all the file that will be updated from the template. 
 
 
  


